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Apttus X-Author Contracts for Mac gives contract administrators and legal teams full access to 

powerful contract negotiation tools inside Salesforce. Log in to your Salesforce org directly from 

Microsoft Word, check out your document and make changes using Word's native features. When 

you are finished, use the X-Author add-in to check-in your document, reconcile clauses, fields and 

other contract elements in an easy-to-use interface. Negotiating parties can insert and modify 

contract terms and clauses and add non-legal language, then check in redlined, clean and final 

versions back to the agreement record. Advanced reconciliation capability also allows users to 

reconcile any terms or clauses that may have changed during the approval process and update 

them in Salesforce. Apttus Contract Management Document Versioning integrates with X-Author, 

meaning document versions can be tracked with ease. Furthermore, users who are already 

familiar with Microsoft Word will also be comfortable using X-Author, as many Word capabilities 

such as the tracking of changes and commenting are already a part of the tool.

X-Author is compatible with agreement documents created from templates using the FX2 

format only.

Let's Get Started
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Key Capabilities

Check out Apttus-tagged documents from the Microsoft Launch from Microsoft Word: 
Word ribbon and start negotiating immediately.

Check-in, check-out, versioning, redlining and advanced Increased Visibility and Control: 
reconciliation.

Easily access pre-approved clause library and Centrally Controlled Contract Library: 
business terms.

Merge data from Opportunities, Accounts and any other objects Salesforce1 Compatible: 
into contracts.

: Follow changes and actions.Audit Trails
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Benefits

Reduce training time for attorneys and others.Quick System Adoption: 

Quickly create, negotiate, version and approve contracts.Smoother Cycle: 

Limit inaccurate contract data or non-standard language.Vastly Reduced Risk: 

Work with contract documents right from the agreement record.Stay in Salesforce: 
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Getting Started

System Requirements

Your computer must meet the minimum requirements listed below to use X-Author Contracts.

Microsoft Office 365 Online or Cloud applications do not support plugins. X-Author 

Contracts can only be used from Microsoft Word running in a Mac OS 

environment.

Requirements which have changed since the last update are highlighted in .bold

System 
Requirement

Minimum Supported Version

Mac OS El Capitan version 11.3.

New features and technologies are continuously deployed in new releases by 
Apttus X-Author Contracts, and they are supported by Apttus where the 
associated Microsoft Office versions are also still supported by Microsoft. As 
Microsoft ends its own support for any Office version, subsequent new Apttus 
releases will no longer be developed, tested, or committed to support the 
application on any Office version which is no longer supported by Microsoft .

Microsoft 

Office

Microsoft Word 2016 version 15.32

Versioning behavior and naming conventions differ when working with documents, 

depending on whether or not Contract Document Versioning is enabled. To learn more 

about document versioning, refer to the Contract Management Admin Guide.
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1.  

2.  

Installing X-Author Contracts

X-Author Contracts for Mac is a Microsoft Word add-in. For the Beta version, you must install the 

manifest (XML) file manually on your system.

In future releases, the add-in will be available from the Microsoft Office store.

To install the X-Author Contracts add-in

Download the X-Author Contracts for Mac file using the link provided by your Apttus pkg 
representative.

Double-click the  file (right-click and Open if file is untrusted).pkg
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3.  

4.  

1.  

2.  

Follow the installation instructions to complete installation.

Quit any open instances of Microsoft Word.

To launch the X-Author Contracts add-in

Open Microsoft Word.

Go to Insert > My Add-ins.
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3.  

1.  

2.  

Choose  from the list of add-ins displayed in the drop-down. Apttus X-Apttus X-Author
Author loads in a new pane to the right of the document window.

Logging in to X-Author Contracts

Before you can work with your agreement documents in X-Author, you must log in to your 

Salesforce org through the add-in.

To log in to X-Author Contracts

Launch Microsoft Word. Open a new document or the document you want to work with.

Launch the X-Author add-in as described in .Installing X-Author Contracts
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3.  

4.  

5.  

After the X-Author add-in pane loads, hover over the icon on the left-hand side to display the 

login menu.

Depending on the org you want to connect to, select  or Sign-In to Production Sign-In to 
.Sandbox

If it is the first time you are logging into the org, you will be prompted to allow X-Author to 

access Salesforce. Click  to proceed.Allow
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6.  Enter your Salesforce credentials to log in. Log in to Salesforce also supports custom 

domains and SSO.
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7. After successful login, the X-Author pane is displayed.

Checking Out an Agreement

To begin working with an agreement document in X-Author, you must .check it out first

There are three common ways for you to check out a document, depending on how you are 

accessing the document itself. Open your DOCX document using one of the following methods:

Checking out the document directly from Microsoft Word.

Download the document directly from the Salesforce agreement record (Notes and 
 related list, or  related list if contract document Attachments Document Versions

versioning is enabled).

Download the document from an email attachment (e.g., Outlook).

In the first case, you open and check out the document in Word at the same time. In the last two 

cases, you are downloading the document onto your computer, then opening it in Word and 

checking it out.
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1.  

2.  

3.  

4.  

In all cases, X-Author marks the document as checked out in Salesforce and locks the document. 

You are the only individual who can work on the document after it is checked out.

If you are working with third party paper and need to check it in to Salesforce for redlining, 

refer to .Importing Offline Agreements

To check out a document

Open Microsoft Word. If you have already downloaded the document from Salesforce or 

another location, open the document in Word. Otherwise, choose a blank document.

Go to  > Insert > My Add-ins Apttus X-Author.

Log in to X-Author Contracts.

(Document currently open in Word) The document is automatically checked out and 

locked by you (you will see a message).

Note: if the document is already checked out by another user, you will not be able 

to work with the document until it is checked in or the lock is released. See Locking 

 for more information.and Unlocking Documents
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5.  

6.  

(No Document open) Click the   icon to browse all agreement records List Agreements
you have permission to access.

(No Document open) Scroll through the list of agreements or use the  tool at the top Search

to search for your agreement record by keyword(s). Click the  icon to view additional 

details about the agreement.
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7.  

8.  

9.  

(No Document open) Click the  button to the right of the agreement record List Document
name to display a list of document versions attached to that record.

(No Document open) Click the  button to the right of the agreement Download Document
version you want to work with. The Document Version is downloaded to your computer.

Open the downloaded document in Word.
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10. You will see the message "Document is locked by you." All menu options are enabled.

Locking and Unlocking Documents

When you check out a document in X-Author, the document is locked for editing and cannot be 

checked out by anyone else. Anyone with proper permissions for the document's agreement 

record can still view and/or download the document, but they cannot make edits and check the 

document back in while you have it locked.

You can always check the lock status of a document by clicking on the   tab.Lock Status

Locks can only be released when a user either manually releases the lock, or checks the 

document into Salesforce.

By default, document locks are used for agreement documents. However, if the Comply 

System Property is enabled the agreement will Use Agreement Locks for Versioning 
be locked instead of a single document. This means that while you or anyone else has a 

document checked out that no other documents for the same agreement record can be 

checked out. Be sure to check whether or not this property is enabled before you begin 

editing a contract document.
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1.  

2.  

To release a document lock

Before you can release a lock on a document, it must be checked out. Releasing a lock reverts the 

check-out of the document you are working on . You can only release a lock without checking it in
when you have the document open in X-Author.

From the X-Author pane, click on the   tab icon.Lock Status
The Lock Status page shows agreement details and information on the current document 

lock.

Click  on the Lock Status page.Release Lock
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3. If you chose to release the lock, the document check-out is reverted. Any changes you made

while the document was checked out are not saved. The page refreshes to reflect unlocked

status and most menu options are disabled.

Note

If you release a document lock in error and want to continue working with the document, 

go to the Lock Status page and click .Acquire Lock

Refreshing document lock status

Because more than one user may have access to agreement documents on an agreement record, 

you may come across a situation where another user has checked out the document.

From the Lock Status tab, you can click the  button at any time to display the current Refresh Lock
lock status for the open document (except for when you have checked out the document already). 

If the document is checked out by another user, the only actions you can take are to List 
 and Refresh Lock.Agreements
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Consider the following example:

Use Case: Reacquiring the document lock from another user

You have opened a contract document version from the agreement's Document Version 

Details in Microsoft Word. Another user checks out the document before you.

A message is displayed showing that the other user controls the lock.

The document cannot be checked out, because another user has already locked it.

You click on the  tab to view the current lock status. The "Document locked Lock Status
by" field shows the document is locked by another user.
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The other user releases the document lock or checks in a new version. You click Refresh 
 to refresh the current lock status. The pane refreshes, showing updated lock status Lock

details.
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You click  to lock the document and start working. All menu items are Acquire Lock
enabled.

Opening a Document You Have Already Checked Out

In some situations, you may close an open document in X-Author which you have checked out, 

without releasing the lock or checking in the document. The document remains locked by you, and 

cannot be edited by anyone else until you release the lock or complete a check-in.

When you open an agreement document in X-Author that is already locked by you, you should see 

the following message displayed at the bottom of the X-Author pane.

Continue working on the document as normal.
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Working with Agreements

After you have checked out your document, you are ready to begin the negotiation and redlining 

process.

The following sections describe the features you can use in X-Author when working with 

agreement documents.

Smart Fields

Smart fields are specialized fields that can retain the Apttus field definition even after Merge 

Service generates an agreement document. Whereas normal fields are generated in documents as 

static text, smart fields can be changed and reconciled back to affect data on the agreement record 

in Salesforce. In a typical scenario where an agreement document is sent to an external party for 

negotiation, the external party will make changes to the document as part of the negotiation. If the 

changes to the document involve data belonging to the agreement record, reconciliation provides 

the mechanism to ensure the values in the document and the Agreement record are reconciled.

Smart fields in generated documents always follow the format of the same field in Salesforce, such 

as dates and strings. , , formula fields for  and Text Area Rich Text fields LongDate Multi-Select 
 are not supported as smart fields.Picklists

Smart Clauses

Smart clauses, like smart fields are parts of a contract that can be reconciled between versions of 

an agreement, and noted in the agreement record. This can be used during negotiations when 

clauses are redlined. Clauses that have been changed will be reconciled when you choose the 

reconciliation option at  . Clauses can only be smart in the context of a generated Check-In
contract document.

In the process of negotiations, a contract may get redlined multiple times. During these redlines, a 

user may choose to accept the changes made to the contract. Smart Clauses provide visibility into 

the changes made in the contract document by allowing the user to view the changed clauses in at 

and when the clause change has been checked in, on the Agreement Clauses related Check-in 
list.
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A Note on Agreement Documents and Templates

All generated agreement documents (as opposed to imported offline agreements) use 

document templates saved in Apttus Contract Management. These templates contain 

merge fields which, upon generation, pull Apttus field values from the agreement to create 

distributable documents. X-Author Contracts for Mac is only used by negotiating parties to 

modify, redline and finalize documents generated in this way. X-Author Contracts for Mac 

has no capability to create or manage templates.

Using Playbook

The Playbook allows you to access a library of previously defined clause templates which already 

exist in your Salesforce organization for use with your document agreement type during 

negotiations. Instead of editing clauses already in the document or inserting static text, you can 

insert clauses from Playbook directly into the agreement document and track and manage 

changes to clause content as negotiations proceed. You can also use Playbook to mark text as 

clauses or fields, applying Apttus properties to these clauses and fields when the document is 

checked in and reconciled.

Unless explicitly stated, any mention in this guide of fields or clauses should be 

considered a reference to smart fields and clauses.

To use Playbook, hover over the   icon in the X-Author pane to display two menu Playbook
choices:  and .Fields Clauses
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You can use Playbook to:

Insert clauses into the agreement document.

Mark document text as a clause.

Mark document text as a field.

When text is marked as a clause or field, the element becomes , meaning that it adopts smart
Apttus properties as a clause or field and users can take various actions on data, allowing them to 

reconcile changes that are reflected in the associated agreement record. For more explicit 

definitions of smart clauses and smart fields, see .Working with Agreements

Inserting Clauses

Playbook lists all clauses available for the specific agreement type associated with the document. 

Clause content typically includes only static text, but it can also contain smart fields, including 

header level and lookup merge fields. When you insert a clause that contains smart fields, field 

values are automatically populated with values from the associated Salesforce agreement record.

When you insert an agreement clause into a document, it is only valid for that specific 

agreement document.

To view the content of a clause listed in the Playbook panel, click on the . A section Clause Name
displaying the Text of the clause is displayed below the clause list. Click on the clause text to 

scroll.
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1.  

2.  

To insert a clause

Hover over the  tab and select  to display a list of clauses in your library.Playbook Clauses

Scroll to the place in your document where you want to insert the clause. Place your cursor 

at the point of insertion.
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3. Click the   icon to insert the clause into your document.Insert Clause

The inserted clause is automatically marked as a smart clause (shown with a grey border). You 

can go to  in the X-Author pane to confirm the clause is now recognized in Document > Clauses
the document. If you decide you want to remove clause properties and revert the clause to static 

text, use the Document panel to . When you check in the document, any smart unmark the clause

clauses can be reconciled to the agreement and information for the inserted clause is added to the 

Agreement Clause related list on the agreement record.

To learn how the Agreement Clause related list is populated with each insert, modify and delete 

action, refer to the  for the Salesforce platform.Contract Management Administrator Guide

At this time, clauses can only be inserted in documents with "Full Access" protection.

Marking Clauses

During the process of negotiation, you may find a section of text that you would like to mark as 

smart. Mark document content as a clause when:

You are with a third party offline agreement created or imported into the agreement record 

that contains language which should be tagged as clauses.

An external party adds language to the agreement document that constitutes a clause.
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1.  

2.  

3.  

By marking this text as a clause in your agreement document, the text adopts the properties of the 

marked clause. You can even choose to replace text in the agreement with text from a pre-existing 

clause in your Playbook. When the agreement document is checked in and reconciled to the 

agreement record, information on marked clauses is added to the  related list.Agreement Clauses

Clauses can only be smart in the context of single generated or offline Apttus agreement 

document.

To mark a clause in an agreement

Hover over the tab and select  to open the Playbook.Playbook Clauses

Highlight the content in the contract to be marked as a clause.

Click on the  icon next to the clause in the Playbook which you want to Mark Clause 
associate with the content.

The Mark Clause form appears inside the X-Author pane.
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3.  

4. The clause will be automatically marked as a 1-off instance of the clause for this agreement.

Specify the following fields for marking the clause.

Field Description

Clause Name Enter a new name for the clause, or leave unmodified (Playbook clause 

name displayed by default).

Action By default, is chosen and is Read-Only.Inserted 

Category Select a category for your clause.

Sub Category Select a sub category for your clause. Options in the list will change 

based on the category you selected.

Exception Select a term exception record from the drop-down list to associate with 

your clause.
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4.  

5.  

6.  

Field Description

Risk Rating Select an appropriate risk rating for your clause. Valid values are:

Green

Red

Yellow

Materially 

Significant

Select this check box if you want to make your clause materially 

significant.

Clause Text 

(Selected)

This text area shows the selected text which you want to mark as a 

clause.

Note

Scroll past the Clause Text to view additional fields and buttons required to mark 

the clause.

Compare the text you have highlighted with the clause library text displayed in the Playbook 

panel. Select if you want Replace current clause selection with the clause from library 
to replace the document content with the text of the clause from Playbook.

Click  to apply Apttus clause properties to the highlighted content and mark the content Save
as a smart clause. When you check in and reconcile your agreement document, the clause 

will be displayed as inserted in the  related list and is listed in the Agreement Clauses
Document panel under .Clauses

If you decide you want to unmark a clause during the same session in which you 

marked it, you must use the  to remove Apttus clause properties. Document Panel

Note that if you chose to replace the text with a clause from the library, you cannot 

choose to unmark the clause, it can only be deleted.
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1.  

2.  

3.  

4.  

Marking Fields

Using Playbook, you can mark small chunks of agreement document content as fields. When you 

mark content in an agreement document as a field, it becomes a smart field. Smart field values can 

be reconciled with data in the agreement record when the document is checked in, allowing 

changes made during negotiation to be accurately reflected and managed as data in Salesforce. 

Content marked as a field must map to the data type of existing fields in your agreement record.

Marking a field in a single agreement does not mark the field across all other documents 

for the same agreement record.

To mark a field in an agreement

Hover over the tab and select .Playbook Fields

Highlight the content in the contract to be marked as a field. 

Click on the  Mark Field icon next to the clause in the Playbook which you want to 

associate with the content. 

The Mark Field dialog appears.

Click  to mark content as a smart field. The content adopts the properties of the same Yes
field on the agreement record.
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4.  

5.  

Make sure the format of the text you are marking matches the data type you are 

mapping to. You will receive an error if the text is not valid for the field type you 

choose.

Hover over the tab and select  to view changed fields in the Document Document Fields
pane. The marked field will be visible in the list.

Make sure to click  to ensure that the newly marked field is in a valid format for the Validate
data type of the field mapped.

When you check in the agreement document and choose to reconcile, values assigned to 

your smart fields are reconciled to the agreement record in Salesforce. 

Using the Document Panel

The Document panel allows you to view all clauses and fields in your agreement document which 

can be edited. These clauses and fields are marked as and  in the smart clauses smart fields
document template from which the document was generated.

Unless explicitly stated, any mention in this guide of fields or clauses should be 

considered a reference to smart fields and clauses.

To use the Document Panel, hover over the   icon in the X-Author pane to display Document
two menu choices:  and .Fields Clauses
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Based on your selection, the Document panel shows either the or  view. You can Fields Clauses
use the Document Panel to:

View changed fields and clauses.

Modify field values.

Reject changes to clause content.

Reject changes to field values.

Validate values of changed fields.

Mark clauses for deletion or undelete a clause.

Unmark marked clauses.

Working with Fields

The  section of the Document Panel lists all smart fields in the agreement document.Fields

Use the Document Panel to take the following actions on fields in the document:

View and change field values in the document.

Update values for multiple occurrences of the same field.

View and/or reject changed field values.

Validate field values.

Mark fields for deletion.
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1.  

To view and change fields

Hover over the   button and select  to open the Document Panel.Document Fields

All fields are displayed in a list in the order they appear in the document. Current 

(document), previous (as of last check-in), and current Salesforce values are displayed.
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1.  

2.  

3.  

4.  

1.  

Click on a field in the list to snap to and highlight the field in the document.

To change the current value of a field, place your cursor in the field content control in the 

document and make changes.

Click  to confirm that the new field value is valid for its corresponding data type.Validate

Did you know?

Changed field values are updated on in the agreement document upon check-in. If 

you choose to reconcile fields during check-in, they will also be changed on the 

agreement record.

To reject changes to a field

If changes have been made to smart fields in the document, you can choose to reject these 

changes in the same session prior to check-in.

To reject changes:

Hover over the   button and select  to open the Document Panel.Document Fields
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1.  

2.  

3.  

Click the  check box to view a list of changed fields.Show changed fields only

Right-click on the changed field in the Document pane (highlighted in red) and select Reject 
.Changes

The field value is reverted to its previous value prior to the change. The Document pane 

reloads to show the change.

To update values for multiple occurrences of a field

The Fields tab in the Documents pane displays, for each field, how many occurrences of the same 

field exist in the agreement document. The numbers to the right of the field name indicate where 

the specific fields appears in the document and how many total occurrences of the field exist. For 

example, "Agreement Start Date (1/3)" indicates that the field is the first occurrence of the 

Agreement Start Date, and that there are two more occurrences elsewhere in the document. Each 

occurrence is displayed in the Fields tab.
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1.  

2.  

3.  

1.  

To update all occurrences of a field in the document to the changed value:

Click on the   icon to the right of the field information on the Document pane.Edit

Click the radio button to select the correct value for all occurrences of the field, and click 

.Update

All occurrences of the field in the document are updated to match your selection.

Click  to validate your changes and refresh the field values displayed in the Validate
Document pane.

To validate fields

Use the  action to ensure that all smart fields in your document are in the proper format for Validate
their assigned data type (e.g., Date, Number, DateTime, selected values from picklists,etc.). The 

agreement document cannot be reconciled at check-in unless all fields in your document are valid.

To validate fields:

Go to .Document > Fields
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1.  

2.  

3.  

Click on the  button. If any fields are invalid, the field row in the Document pane will Validate
be highlighted in red.

Make any corrections to invalid fields as needed and click  again to confirm there Validate
are no invalid fields. If all fields are valid, a success message is displayed at the bottom of 

the pane. You can now check in your document.
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3.  

1.  

To mark fields for deletion

There will be times in the negotiation when a negotiating party wants to remove language from an 

agreement which contains a smart field. Depending on document protection settings, non-Apttus 

users can remove content from the agreement, but any smart field content removed will not 

remove the field itself. Follow the instructions on this page to . You usually mark fields for removal
want to mark fields for removal when:

An Apttus user marked static text as a field.

A Template Admin marked a field as smart.

You need to delete a smart clause from an agreement document.
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1.  

2.  

3.  

Go to .Document > Fields

Right-click on a field and select Mark for Deletion.

Click  on the confirmation dialog that appears. The field is marked with a  in Yes strikethrough

the document and the Document pane to denote that it has been marked for deletion.
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3.  

4.  

1.  

Mark multiple occurrences of a field for deletion

In some cases, the field you are marking for deletion will have more the one 

occurrences in the document. When this occurs, a dialog is displayed prompting 

you to choose whether to delete all or just one occurrence of the field you are 

marking.

Click  to mark all occurrences of the field for deletion,  to mark only Multiple Current
the field you selected, or  to mark no fields.Cancel

Check-in the document and choose . The field is removed from the document.Reconcile

To unmark fields for deletion

If you decide in the same session that you want to keep a field in the document that you have 

already marked for deletion, follow these steps.
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1.  

2.  

3.  

1.  

2.  

Go to .Document > Fields

Right-click on the field in the Document pane that you marked for deletion and select Undo 
.Delete

Click on the confirmation dialog that appears.Yes 

Working with Clauses

The  section of the Document Panel lists all smart clauses in the agreement document.Clauses

Use the Document Panel to take the following actions on clauses:

Navigate to a clause in the document.

Reject changes to a clause. 

Mark a clause for deletion.

Unmark a clause.

To view a clause

Hover over the  tab and select  to open the Documents Panel.Document Clauses

To view only changed clauses, select "Show Only Changed Clauses" at the top of the panel.
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2.  

3. Click on a clause name in the list. The document scrolls to highlight the selected clause.

Sections and supporting documents do not display in the list of clauses if they contain a 

smart field.
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1.  

2.  

3.  

1.  

2.  

To reject changes to a clause

During multiple rounds of negotiation, the text of a clause in your agreement is likely to be 

modified.

Changes to clauses can be tracked over multiple check-ins, as long as redlining is preserved. 

Changes to clauses only become permanent when the document is checked in and .reconciled

To reject the changes to a clause:

 Hover over the  Document tab and select Clauses to open the Documents Panel. 

Click on  to display a list of clauses with changes since the Show Only Changed Clauses
last check-in.

Right-click on the changed clause in the Document pane (highlighted in red) and select 

. The clause is reverted to its previous value prior to the change. The Reject Changes
Document pane reloads to show the change. 

To mark a clause for deletion

When you delete a clause from an agreement, the entire clause is removed from the text of the 

document.

Go to Document > Clauses.

Click the  icon to delete the selected clause. A dialog is displayed in the X-Author pane 

asking you to confirm the deletion.
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2.  

3.  

4.  

1.  

2.  

Click  to mark the clause for deletion. The clause is marked with a  in the Yes strikethrough

document and the Document pane. You can click the  icon to remove the mark at Undo 
any time in the same session.

Check-in the document and choose . The clause is removed from the document Reconcile
and a "Deleted" entry is recorded in the Agreement Clause related list on the agreement 

record in Salesforce.

For more information on tracking clauses and clause activity in your agreements, 

refer to the  for the Salesforce platform. Contract Management Administrator Guide

To unmark a clause

You must have  in the same session marked static text in the agreement document as a clause

using Playbook. Unmarking a clause removes Apttus clause properties and returns the text to a 

static state.

Go to .Document > Clauses

Click on the clause name in the list. The document scrolls to highlight the selected clause.
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2.  

3.  

1.  

Click the  icon. The Panel refreshes and the clause no longer appears in the list. unMark 
The clause boundary is removed from the marked text and it returns to its previous state.

Checking in an Agreement Document

Whether you are saving a redlined version, clean version, or final version, the process for each is 

similar and each makes use of X-Author's Check-In feature.

Only Microsoft Word documents in DOCX format are supported for maintaining versions and 

checking in and checking out agreement documents. When you check in from X-Author, the 

document you are working on is converted back to the same document format as when it was first 

checked out.

To check in an agreement document

From the X-Author pane, click  . The Check-in Options page is displayed.Check In



X-Author for Contracts Mac User Guide Spring 2017 - Salesforce Platform

48 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2. Under  , choose one of three options for saving the document:Options > Save  

Option 
at 
Check-
in

Description

With 
Redlines

This saves a draft version of the agreement document with all markups and 

 is used as the action in your org's configured default document Redlines
naming convention. A DOCX version of the document is saved in Notes & 

. If Contract Document versioning is enabled, selecting this option Attachments
creates a Minor version under the  related list in Document Version Details
your Agreement record.

Without 
Redlines

This saves a draft version of the document without markups and is typically 

done before sending an agreement to a third party for review. Track changes

/redlines are automatically removed from the Word file and  is used as _Clean
the action in the configured default document naming convention. A DOCX 
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2.  

3.  

4.  

Option 
at 
Check-
in

Description

version of the document is saved in . If Contract Notes & Attachments
Document Versioning is enabled, selecting this option creates a Major version 

under the  related list in your Agreement record.Document Version Details

Final - 
to be 
signed

This saves a version of the document without markups and also enables a PDF 

version of the document to be created. If this option is selected, a PDF file will 

be saved to the agreement's  related list. By default, Notes & Attachments
 is used as the action in the configured default document naming _Final

convention. If Contract Document Versioning is enabled, selecting this option 

creates a Major version (DOCX) under the  related Document Version Details
list in your Agreement record.

When you select "Final - to be signed" as the check-in option, Create PDF 
 is automatically checked if you have the Comply System Property attachment

 enabled. For more information on Comply Auto Enable PDF for Final Docs
System Properties, refer to the on the Contract Management Administrator Guide 
Apttus Doc Portal.

In the  field, enter the required name for the document or leave it as the name Name
suggested by X-Author. The default name includes the agreement name, revision number, 

and version type. You do not need to specify a file extension in the  field, Suggested Name
as X-Author automatically saves it in DOCX format.

Select the required watermark option.

Select  to add one to a non-final version. This option is available Include Watermark,
with the  and  options.With Redlines Without Redlines

Include Watermark is automatically deselected (greyed out) if you are saving the 

document as .Final - to be signed
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4.  

5.  

6.  

7.  

8.  

1.  

If the document already contains a watermark, the watermark will be 

removed instead when this option is chosen.

Select  to synchronize the Salesforce Agreement object fields with Reconcile Document
those that were updated in the document. See  for more details.Reconciliation

Select  to enable the  indicator for this agreement (only for use in Mark as private Private
custom implementations–see the Apttus Contract Management Administrator Guide for more 

information).

Click  to confirm check-in of the document. The document is checked in to Submit
Salesforce and the  from the agreement record.new document version is downloaded

Close the document you just checked in (no need to save) and load the newly downloaded 

document to continue working with the agreement, if necessary.

Note

If there are any invalid fields in your agreement, a message is displayed and the check-in 

is not completed. Return to  to validate fields and make corrected as Document > Fields

needed.

For information on enabling Contract Document Versioning and how it works, refer to the Contract 
 for the Salesforce platform.Management Administrator User Guide

Reconciliation

X-Author provides a reconciliation feature which enables changes made to smart fields in an 

agreement document, outside of the Salesforce/X-Author environment, to be reconciled with the 

data held in the Agreement record in Salesforce.

In a typical scenario where an agreement document is sent to an external party for negotiation, the 

external party will make changes to the document as part of the negotiation. If the changes to the 

document involve data belonging to the Agreement record, reconciliation provides the mechanism 

to ensure the values in the document and the Agreement record are reconciled.

To check in and reconcile smart fields and clauses

From the X-Author pane, click  . The Check-in Options page is displayed.Check In
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

Choose the  for saving your document:Options

To check in the document with redlines, choose .With Redlines

To check in the document without redlines (clean), choose .Without Redlines

To check in the document as final, choose .Final - to be signed

To reconcile fields in your document, click . This loads the   View Fields Document > Fields
page.

Review the Current and Previous values for smart fields in your document, make any 

changes as needed and click . If any invalid values exist, correct them and perform Validate
the validation again.

To reconcile clauses in your document, click . This loads the View Clauses Document > 
page. Click  to review any changed smart clauses in your Clauses Show Changed Clauses

document and make changes as required.

Click   to return to the Check-in screen. Repeat Step 2 to choose document Check In
options again.

Select the  check box.Reconcile
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7.  

8.  

1.  

2.  

3.  

If you choose to check in the document without reconciling, changed smart field 

values will not be updated in the agreement record and changes to clauses will not 

be reflected in the Agreement Clauses related list. If you chose to check in the 

document with redlines, redlines and comments will be retained.

Click  to check in the document with reconciliation.Submit

If there are invalid values for smart fields in your document, the check box will not 

enable. An error message is displayed.

Agreement documents cannot be reconciled with the agreement record as long as 

invalid values exist in the document for smart fields. Go to  to Document > Fields
perform a validation and correct any invalid fields.

Opening Agreements in Salesforce

You can easily view the Agreement record associated with your document by choosing "Open in 

Salesforce" from X-Author.

To open an agreement in Salesforce

Connect to X-Author Contracts.

Check-out the agreement document for the agreement you want to view.
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3. From the X-Author menu, hover over the  icon and click Open in Salesforce.

A separate browser window is opened and the agreement is loaded in Salesforce (you may 

have to log in again).
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1.  

2.  

3.  

Importing Offline Agreements

Business requirements often dictate the use of third-party agreements that are not generated using 

Apttus Contract Management templates. In these cases, you need to import those documents into 

Salesforce and apply Apttus properties to use X-Author's features for negotiation.

X-Author Contracts provides a means to import a document into Salesforce and attach it to a pre-

existing agreement record. After you import the document successfully, it is stored on the 

agreement record under  as an imported offline agreement, and available for Document Versions
check out, editing, and redlining in X-Author just as if it were generated in Apttus Contract 

Management.

Importing an offline agreement requires you to have the document stored locally on your computer.

To import an offline agreement

Open the document in Microsoft Word. 

From the X-Author menu, go to List Agreements.
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3.  

4.  

5.  

Scroll through the list of agreements or search for the agreement record you want to 

associate with this document.

Click .Check In Offline

The document is imported into the agreement record, attached to the  Document Versions
Related List and adopts Apttus properties. The new draft is downloaded to your system.

Open the draft that just downloaded in Word. Go to the Lock Status page and click Acquire 
to check out and work with your document. You can now mark fields and clauses and Lock 

use other X-Author features as needed.
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5.  

If you go to the agreement record in Salesforce, you can see the "Imported Offline 

Document" action in the  Related List.Activity History

Copyright ©2017 Apttus. All Rights Reserved.
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